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LAMPIRAN 

Lampiran 1 Daftar Senyawa yang Digunakan Sebagai Bahan Penelitian 

Kode Senyawa Nama Senyawa Struktur 2D 

ZINC00044663 

3-(1H-benzo [d]imidazole -2-

yl)-8((dimethylamino) 

methyl)-7-hydroxy-2H-

chromen-2-one 
 

ZINC00038207 

3-(3-(1H-benzo [d]imidazole-

2-yl)-7-hydroxy-4-oxo-4H-

chromen-2-yl)  propanoic 

acid  

ZINC00848454 

3-(1H-benzo [d]imidazol-2-

yl)-8-((diethylamino) 

methyl)-7-hydroxy-2H-

chromen-2-one 
 

ZINC02134977 

(S)-2-((S)-2-(2,4-dioxo-1,4-

dihydroquinazolin-3(2H)-yl)-

3-methyl butanamido)-2-

phenylacetic acid 
 

ZINC03831405 

(S)-(6-methoxyquinolin -4-

yl)((1S,2R,4S,5R)-5-

vinylquinuclidin-2-yl) 

methanol 
 

ZINC08764772 

(R)-1-(2-(1H-benzo 

[d]imidazol-2-yl) pyrrolidin-

1-yl)-3-(1H-indol-3-

yl)propan-1-one 
 

ZINC08994483 

(2-(2-hydroxy-4-

oxoquinazolin-3(4H)-

yl)acetyl)-D-tyrosine 
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ZINC10959417 

(S)-N-(1-(1H-benzo 

[d]imidazol-2-yl)-3-

methylbutyl)-2-((4-methyl-2-

oxo-2H-chromen-7-yl)oxy) 

acetamide 
 

ZINC12560456 

3-(1H-benzo [d]imidazol-2-

yl)-7-hydroxy-8-(((1R,5S)-

1,3,3-trimethyl-6-

azabicyclo[3.2.1]octan-6-

yl)methyl)-2H-chromen-2-

one 
 

ZINC12956922 

(Z)-2-(1H-benzo [d]imidazol-

2-yl)-3-((3,5-dimethylphenyl) 

amino)acrylonitrile 

 

ZINC20611386 

(2-(2,4-dioxo-1,4-

dihydroquinazolin-3(2H)-

yl)acetyl)-D-tyrosine  

ZINC42025246 

N-(3-(1H-benzo [d]imidazol-

2-yl) propyl)-4-phenyl 

tetrahydro-2H-pyran-4-

carboxamide   

ZINC79190030 

N-(((1S,9aR)-octahydro -2H-

quinolizin-1-yl) methyl)-2-

(trifluoromethyl)-1H-

benzo[d]imidazole-6-

carboxamide 
 

ZINC85878089 

N-((1H-benzo [d]imidazol-2-

yl) methyl)-3-(7-methoxy- 4-

methyl-2-oxo-2H-chromen-

6-yl) propanamide 
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ZINC85879939 

(R)-N-(3-(1H-benzo 

[d]imidazol-2-yl) propyl)-2-

(2,5-dioxo-2,3,4,5-

tetrahydro-1H-

benzo[e][1,4]diazepin-3-

yl)acetamide 
 

ZINC96114364 

(S)-N-(5-(1H-benzo 

[d]imidazol-2-yl) pentyl)-2-

(2,5-dioxo-2,3,4,5-

tetrahydro-1H-

benzo[e][1,4]diazepin-3-

yl)acetamide  

ZINC96115024 

N-(2-(1H-benzo [d]imidazol-

2-yl)ethyl)-3-(7-methoxy-4-

methyl-2-oxo-2H-chromen-6-

yl)propanamide 
 

ZINC96116467 

(S)-N-(1-(1H-benzo 

[d]imidazol-2-yl)ethyl)-3-(7-

methoxy-4-methyl-2-oxo-2H-

chromen-6-yl)propanamide  

ZINC96116483 

(S)-N-(1-(1H-benzo 

[d]imidazol-2-yl)ethyl)-2-

((3,4,8-trimethyl-2-oxo-2H-

chromen-7-yl) oxy)acetamide 
 

ZINC96116495 

N-(3-(1H-benzo [d]imidazol-

2-yl) propyl)-2-((3,4,8-

trimethyl-2-oxo-2H-

chromen-7-yl)oxy) acetamide 
 

ZINC96116529 

(S)-N-(1-(1H-benzo 

[d]imidazol-2-yl)ethyl)-3-(7-

methoxy-4,8-dimethyl-2-oxo-

2H-chromen-3-yl) 

propanamide 
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ZINC96116578 

N-((S)-1-(1H-benzo 

[d]imidazol-2-yl)ethyl)-3-

((R)-2,5-dioxo-2,3,4,5-

tetrahydro-1H-

benzo[e][1,4]diazepin-3-

yl)propanamide  

ZINC96116579 

N-((S)-1-(1H-benzo 

[d]imidazol-2-yl)ethyl)-3-

((S)-2,5-dioxo-2,3,4,5-

tetrahydro-1H-

benzo[e][1,4]diazepin-3-

yl)propanamide  

ZINC98363864 

2-(2,4-dioxo-1,4-

dihydroquinazolin-3(2H)-yl)-

N-(((1R,9aR) -octahydro-2H-

quinolizin-1-yl) 

methyl)acetamide 
 

ZINC98364878 

(R)-3-(2,5-dioxo-2,3,4,5-

tetrahydro-1H-

benzo[e][1,4]diazepin-3-yl)-

N-((6-methyl-1H-

benzo[d]imidazol-2-yl) 

methyl)propanamide 
 

 



 

 

50 
 

Lampiran 2 Pemodelan Struktur 2D dan 3D Senyawa Uji 

Kode Senyawa Struktur 2D Struktur 3D 

ZINC00044663 

  

ZINC00038207 

  

ZINC00848454 
 

 

ZINC02134977 

  

ZINC03831405 

  

ZINC08764772 

  

ZINC08994483 

  

ZINC10959417 

 

 

ZINC12560456 
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ZINC12956922 

  

ZINC20611386 

  

ZINC42025246 

  

ZINC79190030 

  

ZINC85878089 

  

ZINC85879939 

 
 

ZINC96114364 

 

 

ZINC96115024 
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ZINC96116467 

 

 

ZINC96116483 

  

ZINC96116495 

 
 

ZINC96116529 

 

 

ZINC96116578 

  

ZINC96116579 

 

 

ZINC98363864 
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ZINC98364878 
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Lampiran 3 Plot Ramachandran Reseptor (PDB ID : 5IU4) Hasil 

Perbaikan Pemodelan Homologi 
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Lampiran 4 Tabel RMSD Re-docking Ligan Alami 

Rank 
Sub-

Rank 
Run 

Binding 

Energy 

Cluster 

RMSD 

Reference 

RMSD 

Grep 

Pattern 

1 1 50 -8.90 0.00 0.94 RANKING 

1 2 56 -8.86 0.22 0.85 RANKING 

1 3 36 -8.84 0.11 0.88 RANKING 

1 4 7 -8.84 0.23 0.91 RANKING 

1 5 97 -8.77 0.15 0.91 RANKING 

1 6 4 -8.76 0.23 0.92 RANKING 

1 7 62 -8.76 0.32 0.93 RANKING 

1 8 40 -8.73 0.57 0.80 RANKING 

1 9 33 -8.72 0.64 0.89 RANKING 

1 10 60 -8.71 1.29 1.41 RANKING 

1 11 53 -8.71 0.65 0.88 RANKING 

1 12 80 -8.70 0.73 1.02 RANKING 

1 13 63 -8.69 0.72 1.03 RANKING 

1 14 9 -8.68 0.64 0.83 RANKING 

1 15 89 -8.68 0.72 1.04 RANKING 

1 16 82 -8.67 0.65 0.92 RANKING 

1 17 20 -8.66 1.30 1.38 RANKING 

1 18 15 -8.66 0.73 1.02 RANKING 

1 19 30 -8.65 0.73 0.99 RANKING 

1 20 18 -8.65 0.95 0.94 RANKING 

1 21 8 -8.64 0.70 1.08 RANKING 

1 22 2 -8.64 1.33 1.39 RANKING 

1 23 31 -8.63 0.73 1.11 RANKING 

1 24 78 -8.61 0.73 1.07 RANKING 

1 25 68 -8.61 0.73 1.04 RANKING 

1 26 64 -8.60 0.73 1.03 RANKING 

1 27 5 -8.60 0.77 1.12 RANKING 

1 28 14 -8.59 1.28 1.29 RANKING 

1 29 54 -8.59 1.28 1.38 RANKING 

1 30 65 -8.58 0.70 1.10 RANKING 

1 31 98 -8.57 0.91 1.20 RANKING 

1 32 12 -8.57 0.73 1.16 RANKING 

1 33 1 -8.57 0.61 1.07 RANKING 

1 34 91 -8.56 0.85 1.21 RANKING 

1 35 47 -8.56 0.77 1.14 RANKING 

1 36 26 -8.56 1.85 1.40 RANKING 

1 37 42 -8.55 1.95 1.43 RANKING 

1 38 29 -8.55 1.85 1.40 RANKING 

1 39 44 -8.55 1.92 1.40 RANKING 

1 40 86 -8.54 0.71 1.08 RANKING 

1 41 88 -8.53 0.80 0.93 RANKING 

1 42 71 -8.53 0.97 1.28 RANKING 
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1 43 100 -8.53 1.05 1.30 RANKING 

1 44 43 -8.53 1.99 1.44 RANKING 

1 45 99 -8.52 1.11 1.29 RANKING 

1 46 83 -8.51 1.78 1.42 RANKING 

1 47 85 -8.51 1.11 1.29 RANKING 

1 48 45 -8.50 1.22 1.27 RANKING 

1 49 94 -8.50 1.09 1.26 RANKING 

1 50 87 -8.50 1.84 1.39 RANKING 

1 51 58 -8.49 1.28 1.30 RANKING 

1 52 19 -8.46 1.83 1.40 RANKING 

1 53 38 -8.46 0.74 1.19 RANKING 

1 54 6 -8.45 1.78 1.42 RANKING 

1 55 57 -8.44 1.76 1.40 RANKING 

1 56 93 -8.44 1.02 1.30 RANKING 

1 57 92 -8.44 1.65 1.40 RANKING 

1 58 74 -8.43 1.66 1.41 RANKING 

1 59 72 -8.43 1.73 1.41 RANKING 

1 60 90 -8.43 1.64 1.40 RANKING 

1 61 69 -8.42 1.60 1.50 RANKING 

1 62 77 -8.42 1.77 1.43 RANKING 

1 63 48 -8.42 1.68 1.42 RANKING 

1 64 46 -8.40 1.61 1.40 RANKING 

1 65 96 -8.32 1.06 1.35 RANKING 

1 66 61 -8.29 1.93 1.39 RANKING 

1 67 37 -8.29 1.18 1.31 RANKING 

1 68 39 -8.29 1.06 1.37 RANKING 

1 69 25 -8.12 1.08 0.87 RANKING 

1 70 27 -7.68 1.30 1.27 RANKING 

2 1 59 -8.69 0.00 2.83 RANKING 

2 2 75 -8.69 0.10 2.82 RANKING 

2 3 3 -8.68 0.09 2.82 RANKING 

2 4 11 -8.66 0.17 2.80 RANKING 

2 5 13 -8.64 0.18 2.82 RANKING 

2 6 73 -8.62 0.24 2.79 RANKING 

2 7 41 -7.72 1.41 2.65 RANKING 

2 8 32 -7.67 1.80 2.51 RANKING 

2 9 23 -7.63 1.96 2.46 RANKING 

2 10 34 -7.56 1.97 2.43 RANKING 

3 1 52 -8.45 0.00 1.53 RANKING 

3 2 51 -8.44 0.14 1.52 RANKING 

3 3 22 -8.41 0.96 1.69 RANKING 

3 4 49 -8.26 1.33 1.85 RANKING 

3 5 17 -8.11 1.24 1.75 RANKING 

4 1 55 -7.96 0.00 3.27 RANKING 

4 2 16 -7.93 0.20 3.29 RANKING 

5 1 70 -7.59 0.00 9.73 RANKING 
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6 1 76 -7.39 0.00 12.05 RANKING 

6 2 24 -7.39 0.04 12.04 RANKING 

6 3 67 -7.39 0.09 12.04 RANKING 

6 4 79 -7.20 1.12 11.91 RANKING 

6 5 21 -7.17 1.06 12.10 RANKING 

6 6 84 -7.17 1.17 11.76 RANKING 

6 7 35 -7.16 1.08 12.07 RANKING 

6 8 28 -6.35 1.34 12.94 RANKING 

7 1 66 -6.37 0.00 11.60 RANKING 

7 2 81 -6.37 0.06 11.60 RANKING 

7 3 10 -6.34 0.06 11.62 RANKING 

7 4 95 -6.30 0.54 11.65 RANKING 
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Lampiran 5 Tabel Interaksi Reseptor dan Ligan Alami 

Kode 

Ligan 
Interaksi Donor Akseptor 

Jarak 

(Å) 

ZMA  Ikatan Hidrogen      

Sebelum  Conventional H-Bond ZMA N15 GLU169 OE2 2,78 

re-docking  ASN253 ND2 ZMA O25 3,11 

  ASN253 ND2 ZMA N17 3,23 

  ZMA N15 ASN253 OD1 2,86 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 ZMA  3,95 

  LEU249 CD2 ZMA  3,78 

  ZMA C24 HIS250  3,83 

 π - π Stacked ZMA  PHE168  3,71 

  PHE168  ZMA  3,74 

  ZMA  PHE168  5,86 

 π - π T-shaped HIS250  ZMA  4,96 

 π - Alkyl ZMA  MET177  5,13 

  ZMA  LEU249  5,42 

  ZMA  MET270  5,18 

  ZMA  ILE274  5,44 

 Interaksi Van Der 

Waals 
LEU85     

 MET174     

  TRP246     

  HIS264     

  LEU267     

    TYR271         
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Kode 

Ligan 
Interaksi Donor Akseptor 

Jarak 

(Å) 

ZMA  Ikatan Hidrogen           

Sesudah  Conventional H-Bond ZMA N15 GLU169 OE2 2,76 

re-docking  ZMA N15 ASN253 OD1 2,95 

  ASN253 ND2 ZMA O25 2,98 

  ASN253 ND2 ZMA N17 3,08 

 π - Donor H-Bond ZMA O4 HIS264  3,39 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 ZMA  3,82 

  LEU249 CD2 ZMA  3,79 

  LEU249 CD2 ZMA  3,94 

  ZMA C24 HIS250  3,43 

 π - π Stacked PHE168  ZMA  3,74 

  ZMA  PHE168  3,85 

 π - π T-shaped HIS250  ZMA  4,56 

 π - Alkyl MET177  ZMA  5,04 

  ZMA  LEU249  5,28 

  ZMA  LEU267  5,49 

  ZMA  MET270  3,92 

  ZMA  ILE274  5,35 

 Interaksi Van Der 

Waals 
LEU85     

 MET174     

  TRP246     

    TYR271         

*Ket.  Warna hijau : Residu yang interaksinya sama antara sebelum dan sesudah re-docking. 

 Warna merah : Residu yang interaksinya berbeda sebelum dan sesudah re-docking. 
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Lampiran 6 Tabel Interaksi Reseptor dan Senyawa Uji 

Kode Ligan Interaksi Donor Akseptor 
Jarak 

(Å) 

ZINC000012560456 Ikatan Hidrogen      

 Conventional H-Bond RES1 H40 TYR271 OH 1,81 

 Interaksi Hidrofobik      

 π - Sigma MET177 CE RES1  3,87 

  LEU249 CD2 RES1  3,53 

  RES1 C33 HIS264  3,83 

  ILE274 CD1 RES1  3,76 

  ILE274 CD1 RES1  3,99 

 π - π Stacked PHE168  RES1  4,29 

  RES1  PHE168  4,45 

  PHE168  RES1  5,27 

  PHE168  RES1  5,81 

 Alkyl RES1 C31 LEU167  3,49 

  RES1 C32 LEU167  3,51 

  RES1  LEU167  4,75 

 π - Alkyl RES1  LEU85  5,49 

  RES1  MET177  4,82 

  RES1  LEU249  4,43 

  RES1  LEU249  5,43 

  HIS264  RES1  4,79 

  RES1  MET270  5,24 

 Interaksi Van Der 

Waals 
ILE66     

 SER67     

  VAL84     

  LYS153     

  GLU169     

  TRP246     

  HIS250     

  ASN253     

    LEU267         

ZINC000096116483 Ikatan Hidrogen      

 Conventional H-Bond ASP170 N RES1 O6 2,84 

  ASN253 ND2 RES1 N20 2,96 

 π - Donor H-Bond GLU169 N RES1  3,76 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  4,04 

  GLU169 OE2 RES1  4,09 

 Interaksi Hidrofobik      

 π - Sigma MET177 CE RES1  3,94 

  LEU249 CD1 RES1  3,89 

  LEU249 CD2 RES1  3,66 

  LEU249 CD2 RES1  3,87 
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  RES1 C1 HIS264  3,67 

 π - π Stacked RES1  PHE168  3,91 

  PHE168  RES1  4,47 

 π - Alkyl RES1  LEU167  5,14 

  RES1  MET270  4,79 

 Interaksi Van Der 

Waals 
VAL84     

 LEU85     

  MET174     

  TRP246     

  TYR271     

    ILE274         

ZINC000096116495 Ikatan Hidrogen      

 Conventional H-Bond ASP170 N RES1 O6 2,96 

  ASN253 ND2 RES1 N21 2,87 

  RES1 H54 RES1 O15 1,84 

 π - Donor H-Bond GLU169 N RES1  3,83 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE2 RES1  4,37 

  GLU169 OE2 RES1  4,58 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD2 RES1  3,69 

  LEU249 CD2 RES1  3,94 

  RES1 C1 HIS264  3,52 

 π - π Stacked RES1  PHE168  3,87 

  PHE168  RES1  4,92 

 Alkyl LEU167  RES1 C10 5,02 

 π - Alkyl RES1  VAL84  5,23 

  RES1  LEU85  5,48 

  RES1  LEU167  5,1 

  RES1  MET177  5,21 

  RES1  MET270  4,87 

 Interaksi Van Der 

Waals 
LYS153     

 MET174     

  TRP246     

  TYR271     

    ILE274         

ZINC000098363864 Ikatan Hidrogen      

 Conventional H-Bond ASN253 ND2 RES1 O5 2,96 

  RES1 H35 RES1 O1 2,2 

 Carbon H-Bond RES1 C24 GLU169 OE2 3,02 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD2 RES1  3,59 

 π - π Stacked PHE168  RES1  3,66 

  PHE168  RES1  4,87 

 Alkyl MET270  RES1  4,02 

 π - Alkyl RES1  LEU249  4,5 
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  HIS264  RES1  4,84 

  RES1  ILE274  5,26 

 Interaksi Van Der 

Waals 
VAL84     

 LEU85     

  LEU167     

  MET177     

  TRP246     

  LEU267     

    TYR271         

ZINC000096116579 Ikatan Hidrogen      

 Conventional H-Bond GLU169 N RES1 N22 3,08 

  ASN253 ND2 RES1 O20 2,75 

  RES1 H50 TYR271 OH 2,87 

 Interaksi Hidrofobik      

 π - Sigma LEU167 CD1 RES1  3,87 

  LEU167 CD2 RES1  3,97 

  LEU249 CD2 RES1  3,71 

 π - π Stacked PHE168  RES1  5,81 

 π - Alkyl RES1  VAL84  4,47 

  RES1  LEU167  4,75 

  RES1  ILE274  4,76 

 Interaksi Van Der 

Waals 
ILE66     

 LEU85     

  LYS153     

  ASP170     

  MET177     

  TRP246     

  LEU267     

  MET270     

    HIS278         

ZINC000096116578 Ikatan Hidrogen      

 Conventional H-Bond PHE168 N RES1 O11 3,33 

  GLU169 N RES1 O11 2,85 

  ASN253 ND2 RES1 N22 2,93 

 Interaksi Hidrofobik      

 π - Sigma MET177 CE RES1  3,57 

  LEU249 CD1 RES1  3,9 

  LEU249 CD2 RES1  3,7 

  LEU249 CD2 RES1  3,76 

 π - π Stacked RES1  PHE168  4,04 

  PHE168  RES1  5,07 

 π - π T-shaped HIS250  RES1  5,93 

 π - Alkyl RES1  LEU85  5,49 

  RES1  MET177  5,43 

  RES1  MET270  5,31 
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 Interaksi Van Der 

Waals 
ILE66     

 VAL84     

  LEU167     

  ASP170     

  MET174     

  TRP246     

  HIS264     

  LEU267     

  TYR271     

    ILE274         

ZINC000003831405 Ikatan Hidrogen      

 Conventional H-Bond ASN253 ND2 RES1 N16 2,98 

 Carbon H-Bond RES1 C15 ASN253 OD1 2,91 

  RES1 C22 HIS278 NE2 3,6 

       

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 RES1  3,97 

  LEU249 CD2 RES1  3,62 

 π - π Stacked PHE168  RES1  3,77 

  PHE168  RES1  4,08 

 Alkyl RES1 C1 LEU267  4,72 

  RES1 C1 MET270  4,03 

 π - Alkyl HIS264  RES1 C1 5,07 

  RES1  ILE274  5,21 

 Interaksi Van Der 

Waals 
ILE66     

 VAL84     

  LEU85     

  LEU167     

  GLU169     

  MET174     

  MET177     

  TRP246     

  TYR271     

    ALA277         

ZINC000008764772 Ikatan Hidrogen      

 Conventional H-Bond GLU169 N RES1 N20 3,37 

  RES1 H33 ASN253 OD1 2,13 

 π - Donor H-Bond GLU169 N RES1  4,01 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  3,49 

  GLU169 OE2 RES1  4,72 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 RES1  3,91 

  LEU249 CD2 RES1  3,77 

 π - π Stacked RES1  PHE168  3,8 

  PHE168  RES1  3,89 
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  HIS264  RES1  5,52 

 Alkyl RES1  LEU267  5,32 

 π - Alkyl RES1  LEU167  5,03 

  TYR271  RES1  4,72 

 Interaksi Van Der 

Waals 
VAL84     

 LEU85     

  ASP170     

  MET174     

  MET177     

  TRP246     

  MET270     

    ILE274         

ZINC000085878089 Ikatan Hidrogen      

 Conventional H-Bond UNK0 H29 GLU169 OE1 1,86 

  UNK0 H43 GLU169 OE1 2,1 

  UNK0 H50 ASP170 OD1 1,98 

  UNK0 H29 HIS264 NE2 2,82 

 Carbon H-Bond UNK0 C1 ASN145 OD1 2,85 

 π - Donor H-Bond MET174 N UNK0  4,12 

  MET174 NB UNK0  4,12 

 Interaksi Hidrofobik      

 π - Alkyl UNK0  LEU167  4,68 

  UNK0  MET174  5,16 

 Interaksi Van Der 

Waals 
LYS150     

 LYS153     

  PRO173     

  ASN175     

  THR256     

  PHE257     

    PRO260         

ZINC000000848454 Ikatan Hidrogen      

 Conventional H-Bond RES1 H40 TYR271 OH 2,29 

 Interaksi Hidrofobik      

 π - Sigma MET177 CE RES1  4 

  LEU249 CD2 RES1  3,55 

  LEU249 CD2 RES1  3,77 

 π - π Stacked PHE168  RES1  4,01 

  RES1  PHE168  4,34 

  PHE168  RES1  5,23 

  PHE168  RES1  5,75 

 π - π T-shaped HIS250  RES1  5,02 

 π - Alkyl RES1  MET177  5,04 

  RES1  MET270  5,41 

 Interaksi Van Der 

Waals 
ILE66     

 SER67     

  VAL84     
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  LEU85     

  LEU167     

  GLU169     

  MET174     

  TRP246     

  ASN253     

  HIS264     

  LEU267     

    ILE274         

ZINC000096115024 Ikatan Hidrogen      

 Conventional H-Bond GLU169 N RES1 O6 2,83 

  RES1 H44 GLU169 OE2 2,99 

  ASP170 N RES1 O8 3,09 

  ASN253 ND2 RES1 N23 2,83 

  RES1 H53 RES1 O18 2,12 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  4,54 

  GLU169 OE2 RES1  4,98 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 RES1  3,88 

  LEU249 CD2 RES1  3,61 

  LEU249 CD2 RES1  3,74 

 π - π Stacked RES1  PHE168  4,03 

  PHE168  RES1  4,84 

  TYR271  RES1  5,95 

 π - Alkyl RES1  VAL84  5,48 

  RES1  LEU167  4,78 

  HIS264  RES1 C11 4,24 

 Interaksi Van Der 

Waals 
ILE66     

 LEU85     

  LYS153     

  MET174     

  MET177     

  TRP246     

  MET270     

    ILE274         

ZINC000010959417 Ikatan Hidrogen      

 Conventional H-Bond ASN145 ND2 RES1 O5 2,93 

  MET174 N RES1 O5 2,92 

  MET174 NB RES1 O5 2,91 

 Carbon H-Bond PRO173 CA RES1 O5 2,91 

 π - Donor H-Bond TYR271 OH RES1  3,96 

 Interaksi Hidrofobik      

 π - Sigma RES1 C19 HIS264  3,81 

 π - π Stacked TYR271  RES1  5,48 

 Alkyl RES1 C1 MET174  5,44 
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  RES1 C18 LEU267  4,97 

  RES1 C18 MET270  3,8 

 π - Alkyl RES1  MET174  4,72 

  RES1  MET174  5,17 

  PHE257  RES1 C1 5,14 

  HIS264  RES1 C18 4,45 

 Interaksi Van Der 

Waals 
ILE66     

 LEU167     

  PHE168     

  GLU169     

  VAL172     

  ASN175     

  THR256     

  ALA265     

    ILE274         

ZINC000000044663 Ikatan Hidrogen      

 Conventional H-Bond RES1 H34 TYR271 OH 2,07 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD2 RES1  3,53 

  LEU249 CD2 RES1  3,73 

  RES1 C1 HIS264  3,9 

 π - π Stacked PHE168  RES1  4,09 

  RES1  PHE168  4,29 

  PHE168  RES1  5,39 

  PHE168  RES1  5,66 

 π - π T-shaped HIS250  RES1  5,16 

 π - Alkyl RES1  MET177  5,1 

  RES1  MET177  5,41 

  RES1  MET270  5,37 

  RES1  ILE274  5,47 

 Interaksi Van Der 

Waals 
ILE66     

 SER67     

  VAL84     

  LEU85     

  LEU167     

  GLU169     

  MET174     

  TRP246     

  ASN253     

    LEU267         

ZINC000042025246 Ikatan Hidrogen      

 Conventional H-Bond PHE168 N RES1 O25 2,9 

  ASN253 ND2 RES1 N8 3 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  4,66 

 Interaksi Hidrofobik      
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 π - Sigma LEU85 CD2 RES1  3,84 

  MET177 CE RES1  3,93 

  LEU249 CD2 RES1  3,72 

  LEU249 CD2 RES1  3,76 

 π - π Stacked RES1  PHE168  4,05 

  PHE168  RES1  5,33 

  HIS264  RES1  4,17 

 Alkyl LEU167  RES1  4,79 

 π - Alkyl RES1  MET177  5,37 

  RES1  MET270  5,2 

 Interaksi Van Der 

Waals 
VAL84     

 ASP170     

  TRP246     

  LEU267     

  TYR271     

    ILE274         

ZINC000096114364 Ikatan Hidrogen      

 Conventional H-Bond PHE168 N RES1 N24 3,15 

  GLU169 N RES1 N24 2,94 

  ASN253 ND2 RES1 O16 2,79 

 π - Donor H-Bond GLU169 N RES1  3,44 

 Interaksi Hidrofobik      

 π - Sigma GLU169 CB RES1  3,64 

  LEU249 CD2 RES1  3,67 

 π - π Stacked PHE168  RES1  5,88 

 π - Alkyl RES1  VAL84  4,64 

  RES1  LEU167  5,11 

  RES1  LEU167  5,22 

  RES1  ILE274  4,49 

 Interaksi Van Der 

Waals 
ILE66     

 LEU85     

  LYS153     

  ASP170     

  MET174     

  MET177     

  TRP246     

  HIS264     

  MET270     

  TYR271     

  HIS278     

ZINC000098364878 Ikatan Hidrogen           

 Conventional H-Bond ASN145 ND2 RES1 O1 3,05 

  RES1 H30 GLU169 O 1,88 

  RES1 H41 ASP170 OD1 2,04 

  MET174 N RES1 O1 3,17 

  MET174 NB RES1 O1 3,16 
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 Carbon H-Bond PRO173 CA RES1 O1 3,42 

 π - Donor H-Bond GLU169 N RES1  3,74 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  4,19 

  GLU169 OE2 RES1  4,24 

 Interaksi Hidrofobik      

 Alkyl RES1 C29 MET270  3,38 

 π - Alkyl RES1  LEU167  5 

  RES1  MET174  5,47 

 Interaksi Van Der 

Waals 
LYS150     

 LYS153     

  PHE168     

  VAL172     

  THR256     

  PHE257     

  HIS264     

    ILE274         

ZINC000096116467 Ikatan Hidrogen      

 Conventional H-Bond PHE168 N RES1 O18 3,16 

  ASN253 ND2 RES1 O8 2,63 

  RES1 H44 TYR271 OH 2,6 

  RES1 H53 RES1 O18 1,99 

 Carbon H-Bond RES1 C1 RES1 N23 3,39 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  3,4 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 RES1  3,89 

  RES1 C1 RES1  3,98 

 π - π Stacked PHE168  RES1  3,77 

  PHE168  RES1  4,04 

 Alkyl RES1 C11 LEU249  5,27 

  RES1 C11 ILE274  4,22 

 π - Alkyl RES1  LEU167  5,29 

  PHE168  RES1 C11 4,84 

  RES1  ILE274  5,22 

 Interaksi Van Der 

Waals 
ILE66     

 VAL84     

  ASP170     

  MET177     

  HIS264     

  LEU267     

    MET270         

ZINC000079190030 Ikatan Hidrogen      

 Conventional H-Bond ASN253 ND2 RES1 N19 2,69 

  ASN253 ND2 RES1 F24 3,32 

 Interaksi Hidrofobik      
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 π - Sigma LEU249 CD1 RES1  3,97 

  LEU249 CD2 RES1  3,39 

 π - π Stacked PHE168  RES1  3,73 

  RES1  PHE168  4,47 

 Alkyl LEU167  RES1  4,01 

  MET270  RES1  5,07 

 π - Alkyl RES1  MET177  5,47 

  TYR271  RES1  4,87 

  RES1  ILE274  5,33 

 Interaksi Van Der 

Waals 
ILE66     

 VAL84     

  LEU85     

  GLU169     

  ASP170     

  TRP246     

  HIS250     

    LEU267         

ZINC000085879939 Ikatan Hidrogen      

 Conventional H-Bond RES1 H39 GLU169 OE2 2,17 

  ASN253 ND2 RES1 N22 2,79 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  3,58 

 Interaksi Hidrofobik      

 π - Sigma MET177 CE RES1  3,75 

  LEU249 CD1 RES1  3,82 

  LEU249 CD2 RES1  3,5 

  LEU249 CD2 RES1  3,67 

 π - π Stacked RES1  PHE168  4,16 

  PHE168  RES1  5,27 

  HIS264  RES1  5,26 

 π - π T-shaped HIS250  RES1  5,83 

 π - Alkyl RES1  MET177  5,45 

 Interaksi Van Der 

Waals 
VAL84     

 LEU85     

  LEU167     

  ASP170     

  TRP246     

  ALA265     

  LEU267     

  MET270     

  TYR271     

    ILE274         

ZINC000096116529 Ikatan Hidrogen      

 Conventional H-Bond PHE168 N RES1 O13 3,1 

  GLU169 N RES1 O13 3,07 

 Ikatan Elektrostatik      
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 π - Anion GLU169 OE1 RES1  3,22 

  GLU169 OE1 RES1  3,74 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD2 RES1  3,81 

  ILE274 CD1 RES1  3,92 

 π - π Stacked PHE168  RES1  3,79 

  PHE168  RES1  3,82 

 Alkyl RES1 C31 VAL84  4,7 

  RES1 C8 MET270  4,88 

 π - Alkyl PHE168  RES1 C8 4,73 

  PHE168  RES1 C31 4,88 

  RES1  LEU249  5,47 

 Interaksi Van Der 

Waals 
SER67     

 LEU85     

  LYS150     

  LEU167     

  ASP170     

  MET174     

  MET177     

  TRP246     

  ASN253     

  HIS264     

    LEU267         

ZINC000012956922 Ikatan Hidrogen      

 Conventional H-Bond RES1 H29 GLU169 OE2 1,89 

  ASN253 ND2 RES1 N9 3,33 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 RES1  3,96 

  LEU249 CD2 RES1  3,21 

  LEU249 CD2 RES1  3,81 

 π - π Stacked RES1  PHE168  3,85 

  PHE168  RES1  5,04 

 Alkyl RES1 C22 LEU167  4,87 

  RES1 C21 LEU267  4,85 

  RES1 C21 MET270  3,91 

 π - Alkyl RES1  VAL84  5,48 

  HIS264  RES1 C21 4,66 

  RES1  MET270  4,4 

  TYR271  RES1 C22 5,14 

 Interaksi Van Der 

Waals 
SER67     

 LEU85     

  MET174     

  MET177     

  TRP246     

    ILE274         
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ZINC000002134977 Ikatan Hidrogen      

 Conventional H-Bond PHE168 N RES1 O29 2,65 

  GLU169 N RES1 O29 2,86 

  RES1 H40 ASN253 OD1 2,13 

 Ikatan Elektrostatik      

 π - Anion GLU169 OE1 RES1  3,96 

  GLU169 OE2 RES1  3,73 

 Interaksi Hidrofobik      

 π - Sigma GLU169 CB RES1  3,55 

  LEU249 CD2 RES1  3,8 

 π - π Stacked PHE168  RES1  4,62 

 Alkyl RES1 C3 MET270  3,56 

  RES1 C3 ILE274  4,56 

 π - Alkyl RES1  LEU167  5,37 

  TYR271  RES1 C3 4,6 

  RES1  ILE274  4,6 

 Interaksi Van Der 

Waals 
VAL84     

 LYS153     

  ASP170     

  MET174     

  MET177     

  TRP246     

    HIS264         

ZINC000008994483 Ikatan Hidrogen      

 Conventional H-Bond GLU169 N RES1 O1 3,06 

  RES1 H39 ASN253 OD1 1,92 

  ASN253 ND2 RES1 N20 2,99 

 π - Donor H-Bond RES1 H33 HIS264  3,01 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 RES1  3,91 

  LEU249 CD2 RES1  3,52 

  LEU249 CD2 RES1  3,88 

 π - π Stacked PHE168  RES1  3,83 

  PHE168  RES1  4,93 

 π - Alkyl RES1  LEU267  5,31 

  RES1  MET270  4,76 

 Interaksi Van Der 

Waals 
VAL84     

 LEU85     

  LEU167     

  MET174     

  MET177     

  TRP246     

  TYR271     

    ILE274         

ZINC000000038207 Ikatan Hidrogen      

 Conventional H-Bond RES1 H33 TYR271 OH 2,15 
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  RES1 H27 HIS278 NE2 2,8 

  RES1 H40 RES1 O1 2,16 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD2 RES1  3,45 

  LEU249 CD2 RES1  3,74 

  ILE274 CD1 RES1  3,76 

 π - π Stacked PHE168  RES1  3,97 

  RES1  PHE168  4,36 

  PHE168  RES1  5,41 

  PHE168  RES1  5,82 

 π - π T-shaped HIS250  RES1  4,91 

 π - Alkyl RES1  MET177  5,02 

  RES1  MET177  5,47 

  RES1  MET270  5,11 

 Interaksi Van Der 

Waals 
SER67     

 VAL84     

  LEU85     

  LEU167     

  GLU169     

  TRP246     

  ASN253     

    ALA277         

ZINC000020611386 Ikatan Hidrogen      

 Conventional H-Bond PHE168 N RES1 O1 2,68 

  RES1 H35 GLU169 OE1 1,87 

  RES1 H41 GLU169 OE2 2,16 

  RES1 H29 RES1 O19 1,87 

 Interaksi Hidrofobik      

 π - Sigma LEU249 CD1 RES1  3,92 

 π - π Stacked PHE168  RES1  3,74 

  PHE168  RES1  4,35 

 π - Alkyl RES1  MET270  5,15 

 Interaksi Van Der 

Waals 
LYS153     

 LEU167     

  ASP170     

  MET174     

  MET177     

  ASN253     

  THR256     

  HIS264     

  LEU267     

  TYR271     

    ILE274         

 



 

 

73 
 

Lampiran 7 Grafik RMSD Kompleks Reseptor dan Ligan 

  

  

  



 

 

74 
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Lampiran 8 Visualisasi Pergerakan Kompleks Reseptor dan Ligan 

ZINC12560456 Selama Simulasi 

  

 0 ns 10 ns 

  

 20 ns 30 ns 

  

 40 ns 50 ns 
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Lampiran 9 Tabel Nilai RMSF Pada Area Binding Site 

Residu 

RMSF (Å) 

Ligan Alami 

ZMA 
ZINC12560456 ZINC00848454 ZINC96115024 

SER66 1,0408 1,0163 1,1957 1,8186 

VAL83 0,6695 0,5833 0,9076 0,9442 

LEU84 0,6679 0,6436 0,9363 1,0133 

PHE167 0,9533 0,7633 0,9302 1,2126 

GLU168 1,1106 0,9478 1,0398 1,2816 

MET173 1,0231 0,992 0,9595 1,397 

MET176 0,9092 0,9328 0,872 1,1426 

ASN180 0,953 1,0619 1,0315 1,2782 

TRP341 0,8001 0,713 0,8222 0,8927 

LEU344 0,8127 0,7937 0,8101 1,0157 

HIE345 0,8824 0,8498 0,7972 1,0207 

ASN348 1,0146 1,4818 0,8986 1,1811 

HID359 4,6098 2,5474 2,0319 2,3109 

ALA360 3,6088 2,3181 2,0193 2,0683 

LEU362 2,1229 1,5898 1,962 1,8883 

MET365 1,1022 1,1493 1,5397 1,3668 

TYR366 1,0878 1,0688 1,3333 1,272 

ILE369 0,757 0,7769 1,0501 0,8474 

 

Residu 
RMSF (Å) 

ZINC96116483 ZINC08764772 ZINC98363864 ZINC96116578 

SER66 1,2993 1,418 1,2771 1,3548 

VAL83 0,7303 1,0697 0,7412 0,8875 

LEU84 0,7491 1,0239 0,6715 0,7908 

PHE167 1,1296 1,2817 0,9397 1,1288 

GLU168 1,2262 1,3144 1,0715 1,3233 

MET173 1,3208 1,4712 0,975 1,092 

MET176 1,0015 1,3132 0,7971 0,9462 

ASN180 1,1536 1,332 0,8169 0,9636 

TRP341 1,1823 0,9646 0,9806 1,2639 

LEU344 1,1483 1,0721 1,0213 1,2997 

HIE345 1,0612 1,2013 1,0089 1,349 

ASN348 1,2569 1,5179 1,2465 1,1991 

HID359 2,3558 2,9445 2,5834 2,4522 

ALA360 2,0095 2,4658 2,2725 2,1296 

LEU362 2,1525 1,9187 1,886 2,3742 

MET365 1,4058 1,2789 1,2816 1,6579 

TYR366 1,4195 1,2114 1,2763 1,9187 

ILE369 0,9217 0,9439 0,9144 1,0918 
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Lanjutan Lampiran 9…  

Residu 
RMSF (Å) 

ZINC03831405 ZINC96116579 ZINC96116495 ZINC85878089 

SER66 1,3331 1,2964 1,7568 1,444 

VAL83 0,7726 0,8887 0,7311 0,9896 

LEU84 0,7545 0,8354 0,6493 0,9756 

PHE167 0,8522 1,2241 1,2009 1,043 

GLU168 0,9961 1,3893 1,3093 1,1701 

MET173 1,0415 1,088 1,214 1,3355 

MET176 0,9615 1,0382 1,0533 1,3775 

ASN180 0,98 1,1232 1,0472 1,3481 

TRP341 1,0127 1,2126 1,1787 1,1964 

LEU344 1,0646 1,3645 1,2722 1,0907 

HIE345 1,0904 1,4542 1,1887 1,0949 

ASN348 1,1427 1,2253 1,289 1,4976 

HID359 3,2977 2,3375 2,2338 2,7686 

ALA360 2,4249 2,1388 1,7719 2,5007 

LEU362 2,675 1,9647 1,8765 2,7734 

MET365 1,4562 1,5212 1,2642 1,9669 

TYR366 1,6533 1,4436 1,2447 2,198 

ILE369 1,637 1,2039 1,0961 1,3943 
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Lampiran 10 Tabel Ikatan Hidrogen Selama Simulasi 50 ns 

Senyawa Donor Akseptor 
Waktu ke- 

(ns) 

Jarak 

(Å) 

Sudut 

(°) 

Ligan Alami 

ZMA 

ASN348-HD21 ; -ND2 ZMA401-N17 20,297 2,915 162,46 

ZMA-H1 ; -N15 ASN348-OD1 15,287 2,86 152,69 

ZMA-H2 ; -N15 ASN348-OD1 9,951 2,863 153,63 

ZMA-H2 ; -N15 GLU168-OE1 2,295 2,828 157,74 

ZMA-H2 ; -N15 GLU168-OE2 1,836 2,836 157,52 

ZMA-H1 ; -N15 GLU168-OE2 1,727 2,831 159,47 

ZMA-H1 ; -N15 GLU168-OE1 1,336 2,831 159,97 

TYR366-HH ; -OH ZMA401-N10 0,578 2,871 160,75 

LEU362-H ; -N ZMA401-O4 0,219 2,924 155,09 

ZMA-H10 ; -O4 GLU168-OE2 0,114 2,687 162,85 

ASN348-HD21 ; -ND2 ZMA401-O25 0,092 2,9 141,79 

ZMA-H10 ; -O4 GLU168-OE1 0,066 2,685 162,78 

ASN348-HD21 ; -ND2 ZMA401-N15 0,057 2,932 149,13 

TYR366-HH ; -OH ZMA401-O4 0,056 2,877 152,03 

ZMA-H2 ; -N15 ASN348-ND2 0,023 2,953 157,83 

ZMA-H1 ; -N15 HID359-NE2 0,016 2,938 166,67 

TYR366-HH ; -OH ZMA401-N12 0,012 2,924 150,38 

ZMA-H10 ; -O4 TYR366-OH 0,005 2,813 149,51 

ZMA-H10 ; -O4 TRP363-O 0,005 2,882 153,87 

ZMA-H10 ; -O4 ALA360-O 0,003 2,76 156,79 

ZMA-H1 ; -N15 ASN348-ND2 0,002 2,962 137,68 

ZMA-H10 ; -O4 HID359-NE2 0,001 2,996 149,63 

ZINC12560456 

ASN348-HD21 ; -ND2 RES401-O3 7,703 2,883 158,82 

ASN348-HD21 ; -ND2 RES401-N9 0,919 2,931 144,07 

ASN348-HD22 ; -ND2 RES401-N9 0,495 2,916 152,14 

ASN348-HD22 ; -ND2 RES401-O3 0,417 2,844 146,47 

ZINC00848454 

ASN348-HD22 ; -ND2 RES401-N16 15,596 2,912 154,1 

ASN348-HD22 ; -ND2 RES401-O25 10,232 2,85 148,26 

RES401-H40 ; -O9 SER66-OG 10,197 2,745 160,94 

ASN348-HD21 ; -ND2 RES401-O25 1,523 2,857 155,18 

RES401-H40 ; -O9 ILE65-O 0,521 2,699 163,16 

ASN348-HD21 ; -ND2 RES401-N16 0,152 2,924 143,25 

TYR366-HH ; -OH RES401-O9 0,045 2,864 150,33 

RES401-H48 ; -N23 VAL83-O 0,02 2,846 144,28 

SER66-HG ; -OG RES401-O9 0,006 2,902 147,66 

ZINC96115024 

RES401-H53 ; -N30 LEU344-O 24,733 2,823 157,24 

PHE167-H ; -N RES401-O18 20,055 2,885 161,54 

ASN348-HD21 ; -ND2 RES401-N23 9,88 2,916 158,29 

SER66-HG ; -OG RES401-O8 2,792 2,767 155,57 

TYR366-HH ; -OH RES401-O8 0,324 2,789 158,26 
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TYR8-HH ; -OH RES401-O8 0,276 2,766 157,44 

SER66-HG ; -OG RES401-O6 0,093 2,882 154,8 

TYR366-HH ; -OH RES401-O6 0,027 2,929 150,71 

RES401-H44 ; -N19 MET365-O 0,009 2,923 142,18 

ASN348-HD21 ; -ND2 RES401-N30 0,007 2,945 142,14 

RES401-H44 ; -N19 LEU344-O 0,003 2,892 145,5 

SER66-H ; -N RES401-O8 0,001 2,867 136,22 

RES401-H53 ; -N30 ASN348-OD1 0,001 2,972 139,95 

RES401-H53 ; -N30 ASN348-ND2 0,001 2,983 152,01 

ZINC96116483 

ASN348-HD21 ; -ND2 RES401-N20 0,474 2,927 157,24 

SER66-HG ; -OG RES401-O6 0,365 2,796 158,47 

HIE345-HE2 ; -NE2 RES401-O15 0,231 2,845 151,38 

GLU168-H ; -N RES401-O6 0,118 2,914 162,69 

LYS152-HZ1 ; -NZ RES401-O6 0,046 2,867 150,79 

HIE345-HE2 ; -NE2 RES401-N20 0,046 2,9 155,25 

SER66-HG ; -OG RES401-O7 0,016 2,895 153,2 

HIE345-HE2 ; -NE2 RES401-N27 0,002 2,946 147,15 

ASN348-HD22 ; -ND2 RES401-O6 0,001 2,776 171,62 

ASN348-HD22 ; -ND2 RES401-O7 0,001 2,818 171,81 

HID359-HD1 ; -ND1 RES401-O6 0,001 2,86 148,01 

ASN348-HD21 ; -ND2 RES401-O12 0,001 2,963 137,96 

ZINC08764772 

RES401-H49 ; -N27 ASN348-OD1 8,37 2,862 153,76 

ASN348-HD21 ; -ND2 RES401-O1 5,696 2,854 162,53 

ASN348-HD22 ; -ND2 RES401-O1 1,198 2,803 158,84 

PHE167-H ; -N RES401-N20 0,108 2,939 160,04 

ASN348-HD21 ; -ND2 RES401-N20 0,045 2,931 152,33 

RES401-H33 ; -N7 ALA80-O 0,026 2,883 152,35 

ASN348-HD22 ; -ND2 RES401-N20 0,013 2,921 155,81 

RES401-H49 ; -N27 ASN348-ND2 0,004 2,951 152,69 

RES401-H49 ; -N27 LEU344-O 0,003 2,876 154,23 

RES401-H49 ; -N27 MET365-O 0,001 2,691 146,84 

ASN348-HD21 ; -ND2 RES401-N27 0,001 2,961 152,93 

ZINC98363864 

ASN348-HD21 ; -ND2 RES401-O5 17,564 2,849 159,79 

GLU168-H ; -N RES401-O15 6,462 2,884 159,5 

PHE167-H ; -N RES401-O15 1,556 2,867 155,34 

ASN348-HD21 ; -ND2 RES401-O15 1,424 2,881 156,13 

TYR366-HH ; -OH RES401-O1 0,777 2,75 164,08 

RES401-H35 ; -N16 GLU168-OE1 0,627 2,855 157,75 

RES401-H35 ; -N16 ASN348-OD1 0,447 2,872 148,72 

RES401-H35 ; -N16 GLU168-OE2 0,439 2,88 163,71 

SER66-HG ; -OG RES401-O1 0,136 2,708 159,59 

RES401-H28 ; -N8 TYR366-OH 0,13 2,905 152,39 

RES401-H28 ; -N8 GLU168-OE1 0,119 2,832 148,16 
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THR351-HG1 ; -OG1 RES401-O15 0,076 2,764 160,1 

RES401-H28 ; -N8 GLU168-OE2 0,028 2,841 150,08 

TYR366-HH ; -OH RES401-O15 0,006 2,782 161,45 

ASN348-HD22 ; -ND2 RES401-O5 0,001 2,826 152,53 

ZINC96116578 

ASN348-HD21 ; -ND2 RES401-N22 15,238 2,909 155,6 

GLU168-H ; -N RES401-O11 9,921 2,895 162,91 

RES401-H34 ; -N3 ASN348-OD1 7,023 2,854 161,23 

TYR366-HH ; -OH RES401-O11 6,315 2,745 154,69 

PHE167-H ; -N RES401-O11 4,002 2,844 149,27 

ASN348-HD22 ; -ND2 RES401-N22 2,787 2,917 160,53 

RES401-H45 ; -N18 GLU168-OE1 2,561 2,84 152,5 

RES401-H45 ; -N18 GLU168-OE2 2,203 2,841 151,93 

TYR366-HH ; -OH RES401-O5 1,568 2,751 159,92 

RES401-H50 ; -N29 TYR366-OH 1,563 2,894 150,55 

RES401-H50 ; -N29 LEU344-O 0,119 2,808 151,02 

ASN348-HD21 ; -ND2 RES401-O5 0,03 2,896 143,12 

ASP169-H ; -N RES401-O11 0,02 2,951 145,25 

ASN348-HD21 ; -ND2 RES401-N29 0,013 2,954 157,66 

HID359-HD1 ; -ND1 RES401-O20 0,012 2,822 146,55 

RES401-H40 ; -N9 TYR366-OH 0,012 2,891 143,28 

RES401-H40 ; -N9 GLU168-OE2 0,005 2,94 156,88 

RES401-H40 ; -N9 GLU168-OE1 0,003 2,931 155,39 

GLU168-H ; -N RES401-O5 0,002 2,919 151,99 

ASN348-HD22 ; -ND2 RES401-O5 0,001 2,96 161,37 

ZINC03831405 

ASN348-HD21 ; -ND2 RES401-N16 9,058 2,92 152,6 

RES401-H40 ; -O12 MET365-O 0,196 2,847 149,37 

RES401-H40 ; -O12 ASN348-OD1 0,081 2,772 156,13 

ALA360-H ; -N RES401-O12 0,038 2,932 157,44 

HID359-HD1 ; -ND1 RES401-O12 0,035 2,891 154,18 

ASN348-HD21 ; -ND2 RES401-O12 0,026 2,921 158,49 

RES401-H40 ; -O12 ALA368-O 0,007 2,821 159,45 

RES401-H40 ; -O12 ILE347-O 0,002 2,902 151 

SER66-HG ; -OG RES401-O21 0,001 2,891 138,23 

ASN348-HD22 ; -ND2 RES401-N16 0,001 2,936 167,25 

ZINC96116579 

ASN348-HD21 ; -ND2 RES401-O20 15,288 2,846 159,99 

RES401-H50 ; -N29 GLU168-OE2 7,159 2,81 158,45 

ASN348-HD21 ; -ND2 RES401-O5 6,968 2,85 161,49 

RES401-H50 ; -N29 GLU168-OE1 6,942 2,81 158,56 

ASN348-HD22 ; -ND2 RES401-O5 1,553 2,829 162,12 

RES401-H34 ; -N3 TYR366-OH 1,059 2,913 159,61 

ASN348-HD22 ; -ND2 RES401-O20 0,924 2,84 162,16 

RES401-H50 ; -N29 HID359-NE2 0,883 2,919 158,74 

RES401-H34 ; -N3 HID359-NE2 0,555 2,915 157,69 
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TYR366-HH ; -OH RES401-N22 0,447 2,842 156,63 

RES401-H34 ; -N3 SER66-OG 0,333 2,924 162,61 

RES401-H50 ; -N29 HID359-ND1 0,047 2,947 145,7 

RES401-H50 ; -N29 SER66-O 0,022 2,814 150,92 

HIE345-HE2 ; -NE2 RES401-O20 0,021 2,843 146,16 

RES401-H45 ; -N18 HIE345-ND1 0,015 2,929 160,96 

HID359-HD1 ; -ND1 RES401-N22 0,013 2,866 150,94 

GLU168-H ; -N RES401-O5 0,013 2,912 152,98 

GLU168-H ; -N RES401-N22 0,009 2,935 156,95 

RES401-H34 ; -N3 ILE65-O 0,004 2,907 159,29 

SER66-HG ; -OG RES401-O11 0,001 2,756 156,64 

TYR366-HH ; -OH RES401-O11 0,001 2,805 165,74 

ASN348-HD21 ; -ND2 RES401-N3 0,001 2,914 167,84 

RES401-H45 ; -N18 HIE345-NE2 0,001 2,927 159,31 

RES401-H50 ; -N29 ILE65-O 0,001 2,935 137,27 

ZINC96116495 

RES401-H54 ; -N28 GLU168-OE2 10,701 2,82 156,41 

RES401-H43 ; -N16 GLU168-OE1 6,248 2,85 160,08 

RES401-H54 ; -N28 GLU168-OE1 5,946 2,839 153,68 

LEU362-H ; -N RES401-O6 3,561 2,897 153,68 

RES401-H43 ; -N16 GLU168-OE2 3,536 2,852 158,64 

RES401-H43 ; -N16 ALA360-O 2,969 2,872 159,35 

RES401-H54 ; -N28 HID359-NE2 0,63 2,926 154,11 

GLU168-H ; -N RES401-O15 0,596 2,909 160,32 

RES401-H43 ; -N16 HID359-O 0,315 2,879 157,11 

RES401-H43 ; -N16 HID359-NE2 0,192 2,93 157,62 

LEU362-H ; -N RES401-O7 0,086 2,932 162,87 

LEU362-H ; -N RES401-O15 0,085 2,892 152,05 

HID359-H ; -N RES401-O6 0,048 2,901 158,17 

HID359-HD1 ; -ND1 RES401-O15 0,04 2,85 148,62 

TRP363-HE1 ; -NE1 RES401-O6 0,038 2,867 155,12 

RES401-H54 ; -N28 HID359-ND1 0,019 2,947 158,83 

PHE167-H ; -N RES401-O15 0,012 2,865 149,11 

LYS152-HZ1 ; -NZ RES401-O15 0,011 2,84 150,33 

RES401-H54 ; -N28 ASN348-OD1 0,007 2,785 146,89 

RES401-H54 ; -N28 ASN348-ND2 0,006 2,936 152,81 

LYS152-HZ3 ; -NZ RES401-O15 0,005 2,882 147,34 

LYS152-HZ3 ; -NZ RES401-O6 0,005 2,884 155,8 

LYS152-HZ1 ; -NZ RES401-O6 0,004 2,854 150,7 

LYS152-HZ2 ; -NZ RES401-O6 0,004 2,909 148,82 

TRP363-H ; -N RES401-O6 0,004 2,928 167,87 

HID359-H ; -N RES401-O12 0,004 2,959 146,85 

LYS152-HZ2 ; -NZ RES401-O15 0,003 2,857 154,35 

HID359-H ; -N RES401-O15 0,001 2,814 152,52 
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ASP169-H ; -N RES401-O15 0,001 2,911 163,18 

RES401-H43 ; -N16 HID359-ND1 0,001 2,919 175,59 

HID359-HD1 ; -ND1 RES401-O12 0,001 2,946 139,43 

ASN348-HD22 ; -ND2 RES401-N28 0,001 2,952 139,47 

HID359-H ; -N RES401-O7 0,001 2,997 164,31 

ZINC85878089 

THR351-HG1 ; -OG1 UNK401-O18 0,834 2,725 163,03 

ASN144-HD22 ; -ND2 UNK401-O18 0,4 2,826 161,03 

MET173-H ; -N UNK401-O2 0,312 2,92 153,79 

ASN174-HD22 ; -ND2 UNK401-O8 0,182 2,855 158,07 

ASN174-HD22 ; -ND2 UNK401-O18 0,1 2,837 164,45 

ASN174-H ; -N UNK401-O8 0,071 2,894 150,5 

UNK401-H43 ; -N19 ASN144-OD1 0,031 2,897 153,12 

ASN174-HD21 ; -ND2 UNK401-O8 0,024 2,874 156,92 

ASN174-HD22 ; -ND2 UNK401-O2 0,024 2,911 151,77 

UNK401-H50 ; -N29 GLU168-O 0,022 2,906 151,77 

UNK401-H29 ; -N22 ASN144-OD1 0,019 2,873 156,21 

UNK401-H43 ; -N19 THR351-O 0,017 2,908 153,92 

ASN144-HD21 ; -ND2 UNK401-O2 0,014 2,865 156,18 

UNK401-H29 ; -N22 PRO355-O 0,014 2,918 154,54 

ASN174-HD22 ; -ND2 UNK401-O6 0,011 2,944 144,87 

UNK401-H50 ; -N29 ASN144-O 0,009 2,891 144,59 

ASN174-HD21 ; -ND2 UNK401-O2 0,007 2,874 152,08 

LYS149-HZ3 ; -NZ UNK401-N29 0,006 2,946 145,97 

UNK401-H29 ; -N22 THR351-O 0,004 2,898 150,59 

UNK401-H50 ; -N29 ASN144-ND2 0,004 2,923 151,95 

MET173-H ; -N UNK401-O6 0,004 2,937 150,82 

ASN144-HD21 ; -ND2 UNK401-O18 0,003 2,835 152,31 

UNK401-H50 ; -N29 ASN174-OD1 0,003 2,892 159,65 

UNK401-H50 ; -N29 ASN144-OD1 0,003 2,918 150,75 

MET173-H ; -N UNK401-O8 0,003 2,941 141,72 

LYS149-HZ1 ; -NZ UNK401-N29 0,003 2,956 148,15 

ASN144-HD21 ; -ND2 UNK401-N22 0,002 2,862 137,8 

ASN174-H ; -N UNK401-O2 0,002 2,897 147,06 

LYS149-HZ1 ; -NZ UNK401-N22 0,002 2,944 138,81 

UNK401-H29 ; -N22 ASN144-ND2 0,002 2,965 150,44 

ASN144-HD21 ; -ND2 UNK401-N19 0,002 2,978 151,92 

UNK401-H50 ; -N29 ASN174-ND2 0,002 2,981 162,08 

UNK401-H43 ; -N19 ASN144-ND2 0,002 2,994 165,94 

UNK401-H29 ; -N22 ASN174-ND2 0,001 2,807 141,53 

UNK401-H43 ; -N19 THR351-OG1 0,001 2,895 142,12 

ASN174-HD22 ; -ND2 UNK401-N29 0,001 2,909 149,17 

ASN174-HD21 ; -ND2 UNK401-O6 0,001 2,91 147,6 
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UNK401-H29 ; -N22 GLN147-OE1 0,001 2,973 152,78 

LYS149-HZ3 ; -NZ UNK401-N22 0,001 2,999 140,07 
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Lampiran 11 Rincian Prosedur Penelitian 

 

Persiapan Reseptor 

Struktur target yang digunakan yaitu reseptor adenosin A2A diunduh dari website Protein 

Data Bank https://www.rcsb.org/ dengan kode 5IU4 dan format file FASTA (*.txt).  

 

Kemudian dilakukan perbaikan terhadap struktur reseptor tersebut menggunakan 

pemodelan homologi berbasis web yaitu SWISS MODEL 

https://swissmodel.expasy.org/.  

 

 Dipilih Start Modelling untuk memulai pemodelan homologi. 

 Target sequence diinput dalam format FASTA yang tadi sudah diunduh. 

 

 Dipilih Build Model. Secara otomatis, sistem mencarikan dan membangun beberapa 

model yang disesuaikan dengan komponen pada target sequence. 

https://www.rcsb.org/
https://swissmodel.expasy.org/
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 Setelah diperoleh model yang dirasa sesuai, model diunduh dalam format PDB. 

Persiapan reseptor menggunakan perangkat lunak Discovery Studio Visualizer 2016 

dengan memisahkan reseptor dengan ligannya. 

 File “model.pdb” dibuka menggunakan perangkat lunak Discovery Studio Visualizer 

2016. 

 

 Komponen reseptor dipisahkan dengan ligannya dengan cara dipilih menu View => 

Hierarchy. Disorot pada bagian ligan yang akan dihapus, kemudian ditekan tombol 

delete. Setelah itu, file reseptor disimpan dalam format PDB. 

Analisis struktur hasil pemodelan homologi dilakukan menggunakan PROCHECK 

https://servicesn.mbi.ucla.edu/PROCHECK/. 

 

https://servicesn.mbi.ucla.edu/PROCHECK/
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 Dibuka halaman web PROCHECK. Kemudian file reseptor yang sudah terpisah 

dengan ligannya diinput. Setelah itu dipilih Run PROCHECK. 

 

 Setelah selesai, dipilih Main Ramachandran plots untuk melihat dan menganalisis 

plot Ramachandran dari reseptor adenosin A2A yang telah diperbaiki.  

 

Persiapan Ligan 

Struktur senyawa diunduh dari basis data http://zinc.docking.org/.  

 

 Setelah halaman web dibuka, dipilih tab Substances untuk mencari senyawa uji yang 

telah diketahui namanya atau ID. 

 Diinput ID senyawa yang akan dicari, kemudian dipilih Search. 

 Kemudian sistem akan menampilkan struktur dan beberapa keterangan dari ID 

senyawa yang dimaksud. 

 Struktur senyawa uji diunduh dalam format SDF. 

 

Setelah struktur senyawa uji diunduh kemudian digambar ulang dalam bentuk 2D dan 

3D menggunakan perangkat lunak ChemOffice v.12.0.2. 

http://zinc.docking.org/


 

 

87 
 

 

File gambar struktur 3D disimpan dalam format MOL disesuaikan dengan jenis file pada 

perangkat lunak Gaussian09 dan GaussView v.5.0.8. 

 

Optimasi Geometri 

Dilakukan optimasi geometri pada senyawa uji menggunakan perangkat lunak 

Gaussian09 dan GaussView v.5.0.8.  

 File senyawa uji dalam format MOL dibuka menggunakan perangkat lunak 

GaussView v.5.0.8. 

 

Dilakukan optimasi geometri pada senyawa uji menggunakan metode Density Functional 

Theory (DFT), fungsi B3LYP dan basis set 6-31G.  

 Dipilih menu Calculate => Gaussian Calculate Setup. Pada tab Job Type dipilih 

Opt+Freq. Pada tab Method dipilih metode DFT dengan fungsi B3LYP dan basis 

set 6-31G. 
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 Dipilih Submit, kemudian disimpan checkpoint optimasi senyawa uji dengan tipe 

file Gaussian Input File (*.gjf). 

 

 Dipilih Ok pada kotak dialog Run Gaussian untuk memproses Opt+freq. 

 Setelah proses selesai dipilih file dengan tipe Gaussian Output File (*.log) pada 

kotak dialog Gaussian Job Completed, kemudian dipilih Ok. 

 File dengan format LOG disimpan ulang dengan tipe file MDL Mol File (*.mol) 

untuk penentuan parameter sifat fisikokimia dan Sybyl Mol2 File (*.mol2) untuk 

docking senyawa uji. 

 

Penentuan Parameter Sifat Fisikokimia 

Senyawa uji dengan tipe file (*.mol) dibuka menggunakan perangkat lunak Chem3D 

dari ChemOffice v.12.0.2. Penentuan parameter fisikokimia meliputi Koefisien Partisi 

(CLogP), Bobot Molekul (BM), Jumlah Donor dan Akseptor Hidrogen serta 

Refraktivitas Molar (MR). 

 Setelah senyawa uji dengan format MOL dibuka, kemudian dipilih menu 

Calculations => Compute Properties. 

 Pada kotak dialog Property Picker, dipilih sifat fisikokimia Mol Refractivity dan 

Lipinski Rule. 
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 Kemudian setelah dipilih Ok akan muncul data sifat fisikokimia yang dimaksud. 

 

 

Molecular Docking 

Terlebih dahulu dilakukan persiapan terhadap reseptor dan ligan yang akan digunakan.  

 Diunduh file PDB struktur kristal kompleks reseptor adenosin A2A dengan 

ZM241385 (ZMA) sebagai ligan inhibitornya (PDB ID : 5IU4) dari 

https://www.rcsb.org/structure/5IU4. 

 

 File 5IU4.pdb yang sudah diunduh, kemudian dibuka menggunakan perangkat 

lunak Discovery Studio Visualizer 2016. 
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 Dilakukan pemisahan antara komponen reseptor dengan ligan inhibitornya (ZMA), 

serta dihilangkan muatan ion dan komponen airnya dengan cara dipilih menu View 

=> Hierarchy. Kemudian disorot pada bagian ligan ZMA, ion Na dan molekul air 

yang akan dihapus, kemudian ditekan tombol delete. Setelah itu, file reseptor 

disimpan dalam format PDB. 

 Dilakukan hal yang sama pada pemisahan ligan alaminya, dimana semua komponen 

pada kompleks struktur kristal 5IU4.pdb dihapus kecuali ligan ZMA. Setelah itu, 

file ligan disimpan dalam format MOL2. 

Setelah semua komponen disiapkan, dilanjutkan pada proses docking menggunakan 

perangkat lunak Autodock v.4.2.3. 

 Dibuka perangkat lunak Autodock v.4.2.3. 

 



 

 

91 
 

 Dilakukan pengaturan alamat folder kerja untuk mempermudah mencari dan 

menemukan file, dengan cara dipilih menu File => Preference => Set. Pada kotak 

dialog Set User Preferences bagian Startup Directory disesuaikan dengan alamat 

folder kerja, kemudian dipilih Set => Dismiss. 

 Dibuka file reseptor yang sudah dipisahkan dari ligan alaminya, dengan cara dipilih 

menu File => Read Molecule. Kemudian dipilih file reseptor dengan format PDB. 

Dilakukan penambahan atom hidrogen dan muatan parsial pada reseptor dengan cara 

dipilih menu Edit => Hydrogens => Add. Dipilih Polar Only => Ok. Dipilih 

kembali menu Edit => Hydrogens => Merge Non-Polar. Selanjutnya, penambahan 

muatan parsial dilakukan dengan cara dipilih menu Edit => Charges => Compute 

Gasteiger => Ok. 

 Diinput file ligan dalam format MOL2, dengan cara dipilih tab Ligand => Input => 

Open. Dipilih file ligan yang sudah disiapkan. Kemudian dilakukan penentuan sudut 

torsi pada ligan yang dapat berotasi dengan cara dipilih tab Ligand => Torsion Tree 

=> Detect Root. Dipilih kembali menu Ligand => Torsion Tree => Choose 

Torsion. Dipastikan jumlah ikatan yang berotasi maksimum, namun tidak melebihi 

32. Kemudian dipilih Done. Persiapan ligan disimpan dalam format PDBQT dengan 

cara dipilih tab Ligand => Output => Save PDBQT. 

 Dilakukan penentuan grid box dengan cara dipilih tab Grid => Macromolecule => 

Choose, kemudian akan diminta untuk menyimpan file reseptor dalam format 

PDBQT. Dipilih kembali tab Grid => Set Map Types => Choose Ligand, dipilih 

file ligan => Select Ligand. Selanjutnya, dipilih kembali tab Grid => Grid Box. 

Ukuran dan posisi grid box disesuaikan dengan posisi ligand alami pada area binding 

site reseptor target. Apabila sudah selesai diatur, dipilih File => Close Saving 

Current. Kemudian dipilih kembali tab Grid => Output => Save GPF. File 

parameter grid disimpan dengan format GPF (extension .gpf ditulis manual). 
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 Program autogrid dijalankan dengan cara dipilih tab Run => Run Autogrid. Pada 

kotak dialog Run Autogrid bagian Program Pathname => Browse => 

autogrid4.exe, pada bagian Parameter Filename => Browse => grid.gpf. Secara 

otomatis pada bagian Log Filename akan muncul sebagai file outputnya. Pada 

bagian Cmd, dihapus alamat folder kerja pada bagian *.gpf dan *.glg. Dipilih 

Launch, kemudian ditunggu sampai kotak dialog Autodock Process Manager 

menghilang. 

 

 Output Autogrid dapat dilihat dari file *.glg di folder kerja dengan menggunakan 

Notepad. Autogrid dikatakan berhasil apabila terdapat tulisan “Successful 

Completion”. 

 

 Dilakukan proses docking ligand terhadap reseptor target dengan cara dipilih pada 

tab Docking => Macromolecule => Set Rigid Filename, dipilih file reseptor dalam 

format PDBQT => Open. Dipilih lagi tab Docking => Ligand => Choose, dipilih 

file ligan => Select Ligand => Accept. Selanjutnya dilakukan pengaturan parameter 

docking dengan cara dipilih kembali tab Docking => Search Parameter => Genetic 

Algorithm. Pada kotak dialog Genetic Algorithm Parameters bagian Number of 

GA Runs diisi 100, pada bagian Population Size diisi 150 dan pada bagian 

Maximum Number of evals dipilih medium. Bagian yang lain dibiarkan default. 

Kemudian dipilih Accept. 



 

 

93 
 

 

 Dipilih kembali tab Docking => Docking Parameters => Accept. Kemudian file 

parameter docking disimpan dengan cara dipilih tab Docking => Output => 

Lamarckian GA. File disimpan dengan format DPF (extension .dpf ditulis manual). 

 Program autodock dijalankan dengan cara dipilih tab Run => Run Autodock. Pada 

kotak dialog Run Autodock bagian Program Pathname => Browse => 

autodock.exe, pada bagian Parameter Filename => Browse => dock.dpf. Secara 

otomatis pada bagian Log Filename akan muncul sebagai file outputnya. Pada 

bagian Cmd, dihapus alamat folder kerja pada bagian *.dpf dan *.dlg. Dipilih 

Launch, kemudian ditunggu sampai kotak dialog Autodock Process Manager 

menghilang. 

 

 Output Autodock dapat dilihat dari file *.dlg di folder kerja dengan menggunakan 

Notepad. Autodock dikatakan berhasil apabila terdapat tulisan “Successful 

Completion”. 
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 Interpretasi validasi docking dilihat dari nilai Root Mean Square Deviation (RMSD) 

< 2 Å pada file output *.dlg. 

 

 Sedangkan interpretasi docking senyawa uji dilihat dari nilai Free Energy of 

Binding dan Inhibition Constant pada file output *.dlg. 

 

 Untuk mengetahui interaksi ikatan yang terjadi pada konformasi terbaik dari hasil 

docking dilakukan dengan cara dibuka hasil doking senyawa uji pada file *.dlg, 

kemudian dipilih model konformasi dengan energi terendah (Find : Lowest 

energy). 
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 Disalin dan ditempel pada file Notepad baru dari mulai kata “MODEL-ENDMDL”, 

disimpan dengan format *.pdb. File tersebut dibuka beserta file reseptor target 

dengan format PDB menggunakan perangkat lunak Discovery Studio Visualizer 

2016. Ditampilkan Hierarchy, disorot pada file ligan yang ditambahkan, kemudian 

dipilih Ligand Interaction dan pada bagian Non-bond serta Show 2D Diagram. 
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Simulasi Dinamika Molekul 

1. Dilakukan preparasi reseptor dan ligan menggunakan perangkat lunak Discovery 

Studio Visualizer 2016. 

 Digunakan file reseptor yang telah diperbaiki melalui pemodelan homologi, 

dipisahkan dari ligan alaminya, diberi nama 5iu4.pdb. 

 Pada preparasi ligan, digunakan konformasi ligan hasil docking terbaik (lowest 

energy) kemudian ditambahkan atom hidrogen (All), setelah itu disimpan 

dengan format PDB (contoh: z56.pdb). 

 

2. Struktur reseptor diperbaiki menggunakan AMBER v.18. 

 File reseptor dan ligan uji disiapkan dalam satu folder kerja, kemudian ditekan 

Klik Kanan => Open in Terminal. 

 

 Terminal secara otomatis akan menunjukkan lokasi dari folder kerja, 

dilanjutkan dengan : 

$ grep ATOM 5iu4.pdb > 5iu4_rec.pdb 

$ pdb4amber -i 5iu4_rec.pdb --reduce -o 5iu4_amber.pdb 

$ tleap 

 source leaprc.protein.ff14SB 

 x = loadpdb 5iu4_amber.pdb 

 check x 
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 savepdb x 5iu4_fix.pdb 

 quit 

3. Dilakukan parameterisasi ligan 

 Terminal secara otomatis akan menunjukkan lokasi dari folder kerja, 

dilanjutkan dengan : 

$ antechamber -i z56.pdb -fi pdb -o z56.mol2 -fo mol2 -c bcc -s 2 

$ parmchk2 -i z56.mol2 -f mol2 -o z56.frcmod 

$ tleap 

 source leaprc.protein.ff14SB 

 source leaprc.gaff 

 Z56 = loadmol2 z56.mol2 

 loadamberparams z56.frcmod 

 check Z56 

 saveoff Z56 z56.lib 

 saveamberparm Z56 z56.prmtop z56.inpcrd 

 quit 

4. File reseptor dan ligan diunggah ke Leap  

 Terminal secara otomatis akan menunjukkan lokasi dari folder kerja, 

dilanjutkan dengan : 

$ tleap 

 source leaprc.protein.ff14SB 

 source leaprc.gaff 

 loadoff z56.lib 

 loadamberparams z56.frcmod 

 LIG = loadmol2 z56.mol2 

 REC = loadpdb 5iu4_fix.pdb 

 complex = combine {REC LIG} 

 check complex 

 saveamberparm complex complex.prmtop complex.inpcrd 

 savepdb complex complex.pdb 

 

Leap tidak dikeluarkan dulu 
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5. Dilakukan preparasi topologi dinamika molekul 

 charge complex (Tips : - => Na+ / + => Cl-) 

 source leaprc.water.tip3p 

 addions complex Cl- θ 

 charge complex 

 solvatebox complex TIP3PBOX 1θ.θ 

 check complex 

 saveamberparm complex solvated.prmtop solvated.inpcrd 

 savepdb complex solvated.pdb 

 quit 

6. Dilakukan minimisasi sistem 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

min1.in (nama file pada saat disimpan di folder kerja) 

 

min2.in (nama file pada saat disimpan di folder kerja) 

 

 

 

 

 

&cntrl 

imin=1,maxcyc=1θθθ,ncyc=1θθθ, 

cut=9.θ,ntb=1, 

ntc=2,ntf=2, 

ntpr=1θθ, 

ntr=1, restraintmask=':1-4θ1', restraint_wt=5θθ, 

/ 

 

&cntrl 

imin=1,maxcyc=2θθθ,ncyc=1θθθ, 

cut=9.θ,ntb=1, 

ntc=2,ntf=2, 

ntpr=1θθ, 

ntr=1, restraintmask=':1-4θθ@CA,C,O,N,H', restraint_wt=5θθ, 

/ 
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min3.in (nama file pada saat disimpan di folder kerja) 

 

Catatan: restraintmask min1.in (1-401: urutan atom kompleks);  

min2.in (1-400: urutan asam amino reseptor saja)  

(dibuka file complex.pdb). 

 Terminal secara otomatis akan menunjukkan lokasi dari folder kerja, 

dilanjutkan dengan : 

$ mpiexec -n 4 pmemd.MPI -O -i min1.in -o min1.out -p solvated.prmtop -c 

solvated.inpcrd -x min1.crd -r min1.rst      -ref solvated.inpcrd 

$ mpiexec -n 4 pmemd.MPI -O -i min2.in -o min2.out -p solvated.prmtop -c 

min1.rst -x min2.crd -r min2.rst -ref min1.rst 

$ mpiexec -n 4 pmemd.MPI -O -i min3.in -o min3.out -p solvated.prmtop -c 

min2.rst -x min3.crd -r min3.rst  

7. Dilakukan pemanasan sistem 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

heat1.in (nama file pada saat disimpan di folder kerja) 

 

 

 

&cntrl 

imin=1,maxcyc=1θθθ,ncyc=θ, 

cut=9.θ,ntb=1, 

ntc=2,ntf=2, 

ntpr=1θθ, 

/ 

 

&cntrl 

imin=θ, ntx=1, irest=θ,  

ntrpr=2θ, ntwr=2θθθ, ntwx=2θ, 

nstlim=2θθθθ, dt=θ.θθ1, 

ntt=3, gamma_ln=1, tempθ=1θθ, tempi=θ, 

ntb=1, cut=9, ntf=1, 

ntr=1, restraintmask=':1-4θθ@CA,C,N', restraint_wt=5, 

/ 
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heat2.in (nama file pada saat disimpan di folder kerja) 

 

heat3.in (nama file pada saat disimpan di folder kerja) 

 

 Dilanjutkan dengan memberikan perintah pada terminal: 

$ pmemd.cuda -O -i heat1.in -o heat1.out -p solvated.prmtop   -c min3.rst -x 

heat1.crd -r heat1.rst -ref min3.rst  

$ pmemd.cuda -O -i heat2.in -o heat2.out -p solvated.prmtop   -c heat1.rst -x 

heat2.crd -r heat2.rst -ref heat1.rst  

$ pmemd.cuda -O -i heat3.in -o heat3.out -p solvated.prmtop   -c heat2.rst -x 

heat3.crd -r heat3.rst -ref heat2.rst  

8. Dilakukan ekuilibrasi sistem 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

 

&cntrl 

imin=θ, ntx=5, irest=1, 

ntrpr=2θ, ntwr=2θθθ, ntwx=2θ, 

nstlim=2θθθθ, dt=θ.θθ1, 

ntt=3, gamma_ln=1, tempθ=2θθ, tempi=1θθ, 

ntb=1, cut=9, ntf=1, 

ntr=1, restraintmask=':1-4θθ@CA,C,N', restraint_wt=5, 

/ 

 

&cntrl 

imin=θ, ntx=5, irest=1, 

ntrpr=2θ, ntwr=2θθθ, ntwx=2θ, 

nstlim=2θθθθ, dt=θ.θθ1, 

ntt=3, gamma_ln=1, tempθ=31θ, tempi=2θθ, 

ntb=1, cut=9, ntf=1, 

ntr=1, restraintmask=':1-4θθ@CA,C,N', restraint_wt=5, 

/ 
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eq1.in (nama file pada saat disimpan di folder kerja) 

 

eq2.in (nama file pada saat disimpan di folder kerja) 

 

eq3.in (nama file pada saat disimpan di folder kerja) 

 

 

 

 

 

&cntrl 

imin=θ, ntx=5, irest=1, 

ntrpr=1θθ, ntwr=1θθθ, ntwx=1θθ, 

nstlim=1θθθθθ, dt=θ.θθ1, 

ntt=3, gamma_ln=1, tempθ=31θ, tempi=31θ, 

ntb=2, cut=9, ntf=1, ntp=1, 

ntr=1, restraintmask=':1-4θθ@CA,C,N', restraint_wt=3, 

/ 

 

&cntrl 

imin=θ, ntx=5, irest=1, 

ntrpr=1θθ, ntwr=1θθθ, ntwx=1θθ, 

nstlim=1θθθθθ, dt=θ.θθ1, 

ntt=3, gamma_ln=1, tempθ=31θ, tempi=31θ, 

ntb=2, cut=9, ntf=1, ntp=1, 

ntr=1, restraintmask=':1-4θθ@CA,C,N', restraint_wt=1, 

/ 

 

&cntrl 

imin=θ, ntx=5, irest=1, 

ntrpr=1θθ, ntwr=1θθθ, ntwx=1θθ, 

nstlim=1θθθθθ, dt=θ.θθ1, 

ntt=3, gamma_ln=1, tempθ=31θ, tempi=31θ, 

ntb=2, cut=9, ntf=1, ntp=1, 

ntr=θ,  

/ 
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 Dilanjutkan dengan memberikan perintah pada terminal: 

$ mpiexec -n 4 pmemd.MPI -O -i eq1.in -o eq1.out -p solvated.prmtop -c 

heat3.rst -x eq1.crd -r eq1.rst -ref heat3.rst  

$ mpiexec -n 4 pmemd.MPI -O -i eq2.in -o eq2.out -p solvated.prmtop -c 

eq1.rst -x eq2.crd -r eq2.rst -ref eq1.rst 

$ mpiexec -n 4 pmemd.MPI -O -i eq3.in -o eq3.out -p solvated.prmtop -c 

eq2.rst -x eq3.crd -r eq3.rst -ref eq2.rst 

9. Dilakukan analisis hasil pemanasan dan equilibrasi 

$ mkdir analysis 

$ cd analysis 

$ process_mdout.perl ../heat1.out ../heat2.out ../heat3.out ../eq1.out ../eq2.out 

../eq3.out 

 Dilakukan plot energi total, energi potensial dan energi kinetic 

$ xmgrace summary.ETOT summary.EPTOT summary.EKTOT 

 

Apabila grafik pada saat equilibrasi sudah konstan dan stabil, sistem dilanjutkan ke 

tahap produksi. Lokasi terminal dikeluarkan dari folder analysis dan dikembalikan 

ke folder kerja. 

10. Dilakukan produksi dinamika molekul (50 ns) 

Disiapkan terlebih dahulu file input (diketik di Notepad) 
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prod1.in (nama file pada saat disimpan di folder kerja) 

 

Catatan: nstlim x dt = waktu simulasi (ps) 

 Dilanjutkan dengan memberikan perintah pada terminal: 

$ pmemd.cuda -O -i prod1.in -o prod1.out -p solvated.prmtop -c eq3.rst -x 

prod1.crd -r prod1.rst  

11. Dilakukan analisis trajektori 

 Molekul air dan ion dikeluarkan dari sistem 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

strip.in (nama file pada saat disimpan di folder kerja) 

 

Dilanjutkan dengan memberikan perintah pada terminal: 

$ cpptraj solvated.prmtop strip.in 

 Dilakukan analisis RMSD 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

rmsd.in (nama file pada saat disimpan di folder kerja) 

 

 

 

&cntrl 

imin=θ, ntx=5, irest=1, 

ntrpr=5θθ, ntwr=5θθθθ, ntwx=5θθ, 

nstlim=25θθθθθθ, dt=θ.θθ2, 

ntt=3, gamma_ln=1, tempθ=31θ, tempi=31θ, 

ntb=2, cut=9, ntf=2, ntc=2, ntp=1, 

ntr=θ, 

/ 

 

trajin prod1.crd 

trajout dry.binpos binpos 

strip :WAT:Cl- (atau Na+) 

rms first :1-4θ1 

 

trajin dry.binpos 

rms first mass out rms_lig.txt :4θ1@C*,O*,N* 

rms first mass out rms_rec.txt :1-4θθ@CA,C,N 
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Dilanjutkan dengan memberikan perintah pada terminal: 

$ cpptraj complex.prmtop rmsd.in 

$ xmgrace rms_rec.txt rms_lig.txt 

 

 Dilakukan analisis RMSF 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

rmsf.in (nama file pada saat disimpan di folder kerja) 

 

Dilanjutkan dengan memberikan perintah pada terminal: 

$ cpptraj complex.prmtop rmsf.in 

$ xmgrace rmsf.out 

 

 Dilakukan analisis ikatan hidrogen 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

 

 

trajin dry.binpos 

rms first mass @N,CA,C 

atomicfluct out rmsf.out :1-4θθ@N,CA,C nobfactor byres 

 

 

Ket: 

Hitam : Sistem reseptor 

Merah : Sistem kompleks ligan 
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hbond.in (nama file pada saat disimpan di folder kerja) 

 

Catatan: urutan residu asam amino yang berikatan dan urutan atom ligan 

dianalisis menggunakan perangkat lunak Discovery Studio 

Visualizer 2016 dengan membuka file complex.pdb. 

 File complex.pdb dibuka menggunakan perangkat lunak Discovery Studio 

Visualizer 2016. Kemudian ditampilkan Hierarchy dan dipilih bagian 

Ligan Groups => Ligand 1. 

 Dipilih menu Edit => Select. Pada kotak dialog Select, bagian Selection 

Mode dipilih Replece (New Only); bagian Property dipilih Name dan 

bagian Radius dipilih All. Kemudian dipilih Create Group. Group name 

diketik bond (contoh) => Define => Apply => Close. 

 

 Pada bagian Hierarchy dipilih tanda   pada bagian <AminoAcidChain> 

untuk melihat bagian yang berinteraksi. 

Dilanjutkan dengan memberikan perintah pada terminal: 

$ cpptraj complex.prmtop hbond.in 

trajin dry.binpos 

hbond HB out hbond.txt :7-9,62-66,8θ-87,151-153,166-176,18θ-

185,341-351,359-369,4θ1 avgout avgout.txt nointramol series 

uuseries hbseries.txt 

 

 

+ 
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Hasil dari perintah tersebut ialah : hbond.txt; avgout.txt; dan hbseries.txt. 

Berikut ini contoh tampilan avgout.txt. 

 

 Dilakukan analisis MMPBSA/MMGBSA. 

Disiapkan terlebih dahulu file input (diketik di Notepad) 

mmgbsa.in (nama file pada saat disimpan di folder kerja) 

 

Dilanjutkan dengan memberikan perintah pada terminal: 

$ ante-MMPBSA.py -p solvated.prmtop -c complex2.prmtop   -s ‘!:1-4θ1’ -r 

receptor.prmtop -m :1-4θθ -l ligand.prmtop   

$ MMPBSA.py -O -i mmgbsa.in -sp solvated.prmtop -cp complex2.prmtop -

rp receptor.prmtop -lp ligand.prmtop -y prod1.crd  

12. Dilakukan visualisasi hasil dinamika molekul menggunakan perangkat lunak VMD 

v.1.9.3. 

$ VMD 

 Pada VMD Main, dipilih menu File => New Molecule => Browse => 

dipilih complex.prmtop => Ok. 

Browse => dipilih dry.binpos => Ok. 

 Untuk merubah representasi molekul, dipilih menu Graphics => 

Representation. Pada kotak Selected Atoms, diisi resid 1 to 4θθ sebagai 

reseptor dan resid 4θ1 sebagai ligan, serta within 5 of resid 401 sebagai 

ikatan hidrogen. 

&general 

 search_path=1, 

 interval=1θθ, verbose=2, 

 keep_files=2, 

/ 

&gb 

 saltcon=θ.15θ, 

/ 
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Prediksi Toksisitas 

Prediksi toksisitas berbasis web diakses dari situs https://preadmet.bmdrc.kr/. 

 Setelah masuk ke halaman utama dari web PreADMET, dipilih tab Toxicity, 

kemudian digambar struktur senyawa yang akan diprediksikan toksisitasnya pada 

bagian ChemDoodle => Submit. 

 

 Hasil prediksi toksisitas dari senyawa tersebut akan langsung ditampilkan. 

 

https://preadmet.bmdrc.kr/

